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Welcome

Thank you for using the Apex Windows Transfer Utility Software from Compsee, Inc. You have received this program in
conjunction with the purchase of your Apex Portable Data Collection Terminal (PDT) or the Apex Program Generator
application.

The Apex Windows Transfer Utility application is designed to help you easily perform file transfers between a PC (or other
serial device capable of running Windows®) and your Apex PDT. The application program works in conjunction with the
Apex PDT preloaded [dx.exe] File Transfer Utility. Before utilizing this application you should be familiar with the Apex
PDT and the communications techniques outlined in the Apex PDT Technical Reference Manual. The Windows Transfer
Utility application is configured to run on a PC or similar device, which meets the following requirements:

System Requirements

Windows® 95/98/NT operating system

100 MHz Pentium® or better

16 Mb RAM for Windows® 95/98, 32 Mb RAM for Windows® NT
2 Mb of free Hard Disk space

A CD-ROM drive

If you have any questions about the use of this program, after reviewing the HELP files, you can contact Compsee, Inc at
the following number:

1 (800) 768-5248

Copyright Acknowledgements:
Windows® is a registered Trademark of the Microsoft Corporation.
Pentium® is a registered trademark of the Intel Corporation.

Apex” and Compsee® are registered trademarks of McRae Industries



The Apex Windows Transfer Utility Environment

The Apex Windows Transfer Utility utilizes the Windows® Environment and is compatible with Windows® 95/98 and NT
4.0, or later. Within this context, various Windows are used to display information about the utility and/or allow input from
the user. The Window titles listed below comprise the major components of the system.

O The Apex Windows Transfer Utility Main Window

O The Receive Files From The Apex Window

O The Send Files To The Apex Window

In addition to these major windows, various secondary windows allow the user to customize each transfer operation to
their communication specifications. The Secondary Apex Windows Transfer Utility windows are accessed from within the
major application windows or from the various application Menus located at the top of the Main Window.

Basic Windows Techniques

Before using the Apex Windows Transfer Utility Application, you should already be familiar with basic windows techniques
and know how to navigate around in a Windows® based environment. We have included a Windows Basics section
(booklet) in the Apex Windows Transfer Utility Help files located on the Contents tab under the Apex Windows Transfer
Utility Components heading. Should you require a more detailed description of how to navigate within the Windows
environment, refer to the Windows Help Menu of your Windows Operating System or an appropriate Windows® User
manual.

Apex Windows Transfer Utility Menus

The Apex Windows Transfer Utility Main Window contains the following Menu options:
Q Eile Menu

O Communications Menu

a Setup Menu

O Help Menu

Select the Menu Title with the left mouse button to open the sub-menu options. Alternately you can press and hold down
the Alt Key and then press the underlined letter in the Menu Title (ALT + Underlined Menu Title Letter) to open the menu.
e.g. File Menu = ALT + F.

Starting (Opening) The Apex Windows Transfer Utility

Starting (Opening) the Apex Windows Transfer Application by clicking on the Apex Windows Transfer Utility application in
your Windows® Start/Programs menu.

The Apex Windows Transfer Utility Main Window will open automatically with the program ready for you to commence a
communications operation. Application parameters and secondary program windows that allow you to perform
communication operations are accessed through the Menu Bar.

See also: Apex Windows Transfer Utility Menus



The Apex Windows Transfer Utility Main Window

The Apex Windows Transfer Utility Main Window is used as the application workspace for all of the other windows utilized
by the system. The Main application window contains the Title Bar, Menu Bar, the communications Work Area, and the
Scroll Bars (if applicable).

Note: Move your cursor over the Main Window image below to identify Hotspots. Hotspots are identified by showing
you a hand in any hotspot area. Clicking on a hotspot with the left mouse button, will open a hotspot window or
popup window that displays one of the Main Window areas just discussed. Clicking again with the left mouse
button will close the open popup window.

& Apex Il Windows Transfer Uity

Other major application windows used by the system are as follows:

O The Receive Files From The Apex Window
Q  The Send Files To The Apex Window



Receive Files From The Apex Window
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The Receive files from the Apex Window opens when you choose the Retrieve Files sub-menu option from the
Communications Menu. The window allows you to specify files that are to be received from the Apex, what operation is to
be performed for each file (Overwrite, Append, Rename), compile file lists, open file lists, edit file lists, and receive the
designated files from the Apex PDT. When the window opens it is automatically configured to begin a new file list.

To list files to be received from the Apex PDT you can use the Select PC File Name button (preferred method) or simply
type the name into an empty line in the List File Name/Apex File field. You can select an unlimited number of files to
complete your listing for a specific receive operation.

To include files using the Select PC File Name button, left click on the button with your mouse.
The Add A File Window will open allowing you to choose the location (path/folder) and filename
for the received file. Note that you can type in a non-existing file name and extension into the File
Name field to receive the file under a new name or one which doesn’t already exist in the location
selected. Once you have performed this operation, the filename and path will be automatically
appended to the List File Name field in the Receive Files From The Apex Window.

To type in the file name of a file you wish to receive, left click on the first open List File
Name/Apex File field and type the filename.extension. You should note that when using this
method you must also left click on the respective New PC File field in the same line and enter the
path to the location where you want the file to be placed upon receipt (see below example).

ApexFila | Operation | MewPCFila
dxaxe Overwrite  =|[CADDRY_OLDYWAPEX]

To delete a file from the list, simply click on the Apex File name and select the Delete File From
List button. All fields on the same line will automatically be deleted from the list.

Once you have chosen a file or files you must select the appropriate operation to perform upon
receipt. Click on the Down Arrow button in the right side of the respective files Operation field to
choose the Overwrite(default), Append, or Rename operation.

U Overwrite: Upon receipt of the file from the Apex PDT, the received file will automatically
overwrite the new filename in the location (path/folder) chosen.

O Append: Adds the received file information at the end of the selected new filename in the
location chosen.

1 Rename: Places the received file in the selected new filename in the location chosen.



Note: If the new filename already exists, then a filename is automatically generated using the
following format; New filename path + New filename + Number + New Filename
Extension. The number portion of the filename is automatically incremented until a non-
existing filename is created.

To start a new file list, click on the New File List L I button.  Clicking on the New File List
button, clears the present file listing if the file list has been previously saved. If the list has not
been saved, a Save File Dialog Box will appear prompting you to either choose Yes, No, or
Cancel. Choosing “Yes” opens the Save Receive File List Window allowing you to specify a name
and location in which to save the list. Choosing “No” clears the existing list without saving to
begin a new list. Choosing “Cancel”, cancels the operation.

To open an existing file list click on the Open File List _2217EE=t | hytton. If an existing list was still

displayed which had not been saved the Save File Dialog Box will open prompting you to
determine the fate of the list (see above). If any previous listing had already been saved, the old
listing will be cleared from the Receive Files From The Apex Window and the Open Receive File
List Window will appear.

To save the displayed File List click on the Save File List =22 7eL

File List Window will appear.

button. The Save Receive

Clicking on the Receive Files M button, initiates the receive operation of the displayed file list from the Apex
PDT using the communications parameters you have previously set in the Setup Menu (Port and Speed submenus). A
YMODEM protocol transfer will be initiated and if no preferences have been set, communications parameters will defaults
to the COM1 and 115,200 baud). For a more detailed discussion on Apex communications process refer to the Apex PDT
Technical Reference Manual. At the completion of the transfer, a Transfer Status Report will be displayed in the
Communications Status box (the status of each individual file transfer is depicted unless the entire transfer was a failure).
Close the Receive Files To The Apex Window when you have completed all of the receive operations.

Selecting the Show Comm. Status Window checkbox displays a status window during the transfer operation showing you
the status of the file transfer.

Selecting the Close Window When Complete checkbox, closes the Receive Files From The Apex Window automatically
upon completion of the receiving operation.



Add A File Window

Upon opening, the Add A File Window displays the files listed within the Windows Transfer Utility’ home directory (by
default).
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Note: When opening this window from the Send Files To The Apex Window the .exe File Type (Apex Generated
Program) will be automatically chosen in the “Files of type” field. When opening the window from the Receive
Files From The Apex Window the All Files (*.*) File Type will be automatically chosen. In each case, the
subsequent type will be displayed within the Open Directory field.

Select the file you wish to add to the Send Files To The Apex Window/List File Name area and left click the OK button. The
selected filename and path will appear in the List File Name field within the Send Files To The Apex Window. If the file you
wish to send is on another drive or in another directory, migrate to the correct drive/directory by using the directory down
arrow or the up one Level button in the Open Apex Template Window.
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If you wish to send a different type of file, click on the down arrow button to the left of the “Files of Type:” field and select
the appropriate file type option.

Return to the Send Files To The Apex Window
Return to the Receive Files From The Apex Window

Save File Dialog Box
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Save Receive File List Window

Save Receive File List
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The Save Receive File List Window allows you to save a Receive File List. This is especially useful if you have a list of
files which require periodic downloading/updating.

Type the name you wish to save the file listing under in the File Name field. Note that the .RFL extension will automatically
be added to the filename (see “Files of Type” field). Choose the location where you wish to save the file
(drive/folder/subfolder etc.) and click on the save button.

Return to the Receive Files From The Apex Window

Send Files To The Apex Window

The Send files to the Apex Window opens when you choose the Send Files sub-menu option from the
Tools/Communications Menu. The window allows you to specify files to be sent, compile file lists, open existing file lists,
edit file lists, and send the designated files to the Apex PDT. When the window opens it is automatically configured to
begin a new file list.

Send files 1o the Apex I
List File Namea:

Dipin File List I
Seve File List |

Communicate
with Apex Il

it Files I

Show Comem.
Status Window

Communications Results

Close Window
when complate:

adrie | Delewrie | ﬂ,

m

To add a file to the new file list click on the Add File Button. The Add a File Window will open
allowing you to specify a file to be appended to the list. To remove a file from the list, click on the
filename within the List File Name field (the name will become highlighted), then select the Delete
File Button. The file will be removed from the list.

Clicking on the New File List L B! | button clears the present file listing if the file list has been
previously saved. If the list has not been saved, a Save File Dialog Box will appear prompting you
to either choose Yes, No, or Cancel. Choosing “Yes” opens the Save Send File List Window
allowing you to specify a name and location in which to save the list. Choosing “No” clears the
existing list without saving to begin a new list. Choosing “Cancel”, cancels the operation.

Clicking on the Open File List w button opens the Open Send File List Window allowing you to select an
existing file list for editing or sending to the Apex.




Clicking on the Save File List M button opens the Save Send File List Window allowing you to name and
specify a location to save the displayed file list.

Clicking on the Xmit Files ﬂ button, transmits the displayed file list to the Apex PDT using the communications
parameters you have previously set in the Setup Menu (Port and Speed submenus). A YMODEM protocol transfer will be
initiated and preferences if not set, will default to COM1 and 115,200 baud. For a more detailed discussion on Apex
communications refer to the Apex PDT Technical Reference Manual. At the completion of the transfer, a Transfer Status
Report will appear in the Communications Status field (the status of each individual file transfer is depicted unless the
entire transfer was a failure). Close the Send Files To The Apex Window when you have completed all of send operations.

Selecting the Show Comm. Status Window checkbox display a status window during the transmit operation showing you
the status of the file transfer.

Selecting the Close Window When Complete checkbox, closes the Send Files To The Apex Window automatically upon
completion of the send operation.

Save Send File List Window

The Save Send File List Window allows you to save a Send File List.
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This is especially useful if you have a list of files which require periodic updating.

Type the name you wish to save the file listing under in the File Name field. Note that the .SFL extension will automatically
be added to the filename (see “Files of Type” field). Choose the location where you wish to save the file
(drive/folder/subfolder etc.) and click on the save button.

Return to the Send Files To The Apex WIndow

Open Send File List Window
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Select the drive/folder and name of the file list you wish to open (by default the window will automatically open to the folder
containing the Apex Windows Transfer Utility application). If the file list you wish to open is in another directory (folder) or
on another drive use the Down Arrow or the Tree buttons to migrate to the correct location. Click on the file list name you
wish to open (note the name will appear in the File Name field), then click on the Open button.



The names of the files contained within the file list will appear within the List File Name field of the Send Files To The Apex
Window. Note that the path and file list name appears above the List File Name area. Modify the listing as necessary by
utilizing the features available within the Send Files To The Apex Window.

Return to the Send Files To The Apex Window

About The Apex Windows Transfer Utility HELP Files

The Apex Windows® Transfer Utility Application Help Files are designed to assist you in learning and using the full
capabilities of the Apex Windows Transfer Utility. Use of these files will greatly enhance the speed in which you learn to
use the application and begin your first Apex PDT communications.

Q Context Sensitive Help (help for the Windows Transfer Utility area where the cursor is located or the active window)
can be obtained by pressing the F1 key on your keyboard.

O Use the Help File Contents Tab to navigate your way through the various Help files much the way you would use My
Computer or Windows Explorer.

O Use the Help File Index Tab to find keywords located in the Help File Titles index and areas with which you require
assistance.

O Use the Help File Find Tab to identify Help file areas containing a keyword or words for which you need assistance.

Apex Windows Transfer Utility Help Files created by Docu-Write, Mooresville, NC. 28115 exclusively for Compsee, Inc. All
Rights Reserved 2001.

Title Bar
Displays the Window Title at the top of the Window area.

Menu Bar

Display the Apex Windows Transfer Utility application Menus. If a menu is active the Menu Title appears in black. If a
menu is inactive (cannot be used during a specific operation), the Menu Title will be grayed out. The Apex Windows
Transfer Utility Main Menu items are the File Menu, Communications Menu, Setup Menu, and the Help Menu

Work Area

The Work Area is the main area within the Windows Transfer Utility Main Window where the communication work is
conducted. The Apex Windows Transfer Utility secondary application windows are loaded within this area allowing the
user to interface with the program and the Apex PDT.
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Window Control Buttons

The Window Control Buttons control the size of the active Window and or close the window completely.

-|0] X

Close Butten

Maximize Buitcn

Minimeze Butlon
Minimize Button: Causes the Window size to be reduced to it's smallest area and be placed on the Windows®
Status Bar..
Maximize Button: Causes the Window to grow to it’'s maximum area which will fill the entire Windows® screen.
Close Button: Closes the Window and removes it from the Windows screen. The Window will have to be re-

opened from the View Menu if this operation has been performed.
Changing The

Window Size: Most of the internal Apex Windows Transfer Utility Windows have a preset size, which cannot
be altered. If a window allows variable size control (e.g. the Main Window) you can change a
window's size as follows (note this only applies when a window is not maximized):

> Carefully place the mouse cursor over window border until the cursor becomes a two-

sided arrow.

> Press and hold the left mouse key down and drag the edge of the window to the position

desired.
> Change two sides at once, by placing the cursor in the window corner and dragging
diagonally.
Scroll Bar
= H

The Scroll Bars allows the user to scroll through the application window to view items which are larger
than the window itself or larger then the applicable window section. You will not have a scroll bar
within the Main Window unless a secondary windows position “underlays” the Main Window’s border
(open a secondary window, grab the window by the title bar, and position it so some of the window
“underlays” the Main Windows side or bottom border — a scroll bar will appear). Depending on the
secondary windows position, either a Horizontal (above) or Vertical (right) Scroll Bar will be displayed.
A Horizontal Scroll bar (normally located at the bottom of the window ) allows the application
programmer to "scroll" horizontally within the designated window or applicable window section. The
Vertical Scroll Bar (normally located on the right side of the window or applicable window area allows
the application programmer to "scroll" vertically to view the entire contents of the designated window
or window section.

Scrolling methods include:

O  Continually clicking on a scrolling arrow until the desired window area is being displayed. If you
go too far, click on the arrow pointing the opposite direction.

Q  Clicking on the scroll bar locator, holding down the left mouse button and dragging the locator
until the desired window area is being displayed, then releasing the left mouse button.

Q  Clicking with the left mouse button on an empty area of the scroll bar in the direction you wish to
view.
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File Menu

The File Menu is the first menu on the Apex Windows Transfer Utility Menu Bar. Clicking on the File Menu allows the user
to choose the Exit option, closing the Apex Windows Transfer Utility Application and returning you to the Windows
Desktop. This operation is normally performed when you have completed all of your required communications tasks.

| Elle

Exit

Communications Menu

Communications

" Retrieve Files
=mit Filas

The Communications Menu is available to the user from the Main Window Menu Bar. By left
clicking on the Communications Menu, the user can choose from two available sub-menus
options:

Retrieve Files: Choosing the Retrieve Files option, opens the Receive Files From The Apex Window.
Xmit Files: Choosing the Xmit Files option opens the Send Files To The Apex Window.
Setup Menu
I Setup
Bot
Spesd b

The Setup Menu is accessed from the Apex Windows Transfer Utility Main Window Menu Bar. Left clicking on the Setup
Menu allows the user to choose between two sub-menu options:

Port: Choosing the Port sub-menu option displays a choice of COM. Ports to utilize when communicating with the
Apex PDT. Choose the PC port that you are going to connect to the Apex PDT serial connector (RS-232) or
Apex Dock (IR communications). The default port is COM1. Refer to your PC manual (configuration) and the
Apex PDT User’'s Manual and Technical Reference Manual for additional details on conducting Apex
communications.

Speed: Choosing the Speed sub-menu option displays a choice of baud rates at which the communications process will
be conducted. The user can choose one of the following speeds:

Baud Rate
9600

19200

38400

57600

115200 (default)

Note: For proper communications to occur, you must ensure the Apex PDT [dx. exe] program is set for the same
baud rate.
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Help Menu

The Help Menu displays the various Help options available for the Apex Windows Transfer Utility Application. Left click on
the option which you wish to utilize and the appropriate item will open.

Also refer to About the Apex Windows Transfer Utility HELP Files for additional information.

Conducting Communications With The Apex PDT

Notes:

1.

Normally the PC serial RS-232 port is used to conduct communications with the Apex PDT (using cable PN
0227001). Other PC ports can be used depending on your PC’s configuration. Contact Compsee, Inc. for available
cable information.

If conducting Apex communications using the Apex Dock, the Apex IR port must be enabled (refer to the Apex PDT
Technical Reference Manual for additional information).

The Apex PDT’s [dx.exe] utility implementation of the YMODEM protocol includes the file time and date parameter.
Like all YMODEM utilities that implement the time/date parameter, the time/date is sent as Greenwich Mean Time
(GMT). Transmitting or receiving a file from a system utilizing a different time zone will result in a received file time
different than the original transmitted file time. e.g. The Apex will receive a file from a PC set for the Eastern
Standard Time zone with a time stamp of the original EST + 5 hours. Sending a file from the Apex to the PC will
result in a time stamp of the original EST - 5 hours. Note that if you are in a different time zone, the difference will
vary by the amount of time difference between your time zone and GMT.

Communications Guidelines

A

With the PC turned-off connect the Apex approved cable to the PC port to be utilized
(generally the serial port).

If using the Apex PDT internal serial port or Serial End Cap, power down the Apex PDT and
connect the other end of the cable to the unit.

Boot the PC and the Apex PDT.
Open the Apex Windows Transfer Utility application on your PC.

Choose the communications operation you wish to perform by selecting either the
Communications/Retrieve Files menu (receiving files from the Apex) or the
Communications/Xmit Files menu (sending files to the Apex).

Configure the secondary application window (either the Send Files To... or the Receive Files
From...) in the prescribed manner for the operation you wish to perform.

Receive Files From The Apex Window

Send Files To the Apex Window

Prepare the Apex PDT for a file transfer by using the [dx.exe] utility (pre-installed on the
Apex at the factory). Refer to the Apex PDT Technical Reference Manual for details on the
[dx.exe] utilities use and configuration and for communication operation information in
general. Note that the Apex PDT IR port MUST be enabled for communications using the
Apex Dock.

Use the Save File List button LSRR 16 save any Receive File Lists or Send File Lists that
may be used on a routine basis to configure your Apex PDT.

Perform the transfer (communication process) by choosing the Receive Files button

o= | (Receive Files From ...Window) or the Xmit Files button _ ™% | (Send Files
To...Window).

Verify the communication process was successful.

Close the Apex Windows Transfer Utility application.
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Closing (Exiting) The Apex Windows Transfer Utility

Note: It is recommended that you save any File List before closing (exiting) the program.
There are several ways to Exit the Apex Windows Transfer Utility Application.

Using The File Menu:

| Elle

Exit
Left click on the File Menu.
Left click on the Exit sub-menu.
The Windows Transfer Utility Application will close.
Using The Close Button:

O  Left click on the %] Close Button in the top left hand corner of the Apex Windows Transfer Utility Main Window.
Q The Windows Transfer Utility Application will close.

Technical Support

Technical Support for the Apex Windows Transfer Utility and the Apex PDT are available from Compsee, Inc. through the
following methods:

Through our Website: "http://www.compsee.com/"
By phone: (800) 768-5248
Via E-mail: support@compsee.com

Before calling please follow these guidelines:

Refer to the appropriate sections of this HELP Files to ensure you have correctly performed the operation or function in
question.

Have the Apex Windows Transfer Utility Version Number in-hand.

Have your PC's information handy (System information, Operating System type, etc.), a complete description of the
problem as well as when it occurs.

Compsee, Inc.
Contact Information

www.compsee.com
1 (800) 628-3888
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